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Copyright
Copyright © 2009 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.

RM-598; RM-604
Care and maintenance

Page vi COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Ion batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Nokia 7230; L3&4 Service Manual Structure
1 General information
2 Service Devices and Service Concepts
3 BB Troubleshooting and Manual Tuning Guide
4 RF Troubleshooting
5 System Module
Glossary
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 Product selection
RM-598/RM-604 is a WCDMA/GSM handportable phone with a slide form factor. RM-598 supports EGSM
850/900/1800/1900 and WCDMA 850/1900/2100. RM-604 supports EGSM 850/900/1800/1900 and WCDMA
900/1900/2100 bands. The device supports GPRS/EGPRS and WCDMA data bearers.

For WCDMA the maximum bit rate is up to 384 kbps for downlink and 384 kbps for uplink with simultaneous
CS speech or CS video (max. 64 kbps).

For GPRS/EGPRS networks the device is a Class B EGPRS MSC 32 (5 Rx + 3 Tx, max sum 6), which means a
maximum downlink speed of 296 kbps and uplink speed of 177.6 kbps. The device also supports Dual Transfer
Mode (DTM) for simultaneous voice and packet data connection in GSM/EDGE networks; simple class A, multi
slot class 11, (4 Rx + 3 Tx, max sum 5 ), downlink speed of 177.6 kbps and uplink speed of 118.4 kbps.

The device is an MMS (Multimedia Messaging Service) enabled multimedia device. The MMS implementation
follows the OMA MMS standard release 1.3. The device also supports Bluetooth 2.1 standard with the stereo
audio profiles.

The device has a large 2.4’’ QVGA (320 x 240 pixels) TFT display with 262K colours. It also has a 3.2 Megapixel
EDOF camera with 4 x digital smooth zoom and 3GP video player/recorder.

The device supports the S40 Compact UI and S40 OSS web browser, which brings desktop-like Web browsing
experience to mobile devices.

The device also supports MIDP Java 2.1, providing a good platform for compelling 3rd party applications.

Figure 1 RM-598/RM-604 product picture

 Product features and sales package

Bearers and transport
• GSM/EDGE Class B, Multi slot class 32
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• GPRS/EGPRS Class B, Multi slot class 32

• WCDMA 384 kbps uplink/ 384 kbps downlink,

• GSM/EDGE Dual Transfer Mode (DTM) class A, multi slot class 11

Connectivity
• Bluetooth 2.1 with stereo audio profiles

• USB2.0 Full Speed with micro USB interface

• MicroSD memory card - support up to 16 GB

• 3.5 mm Nokia AV Connector

• 2 mm charging connector

• Complementary USB charging

Display
• Large 2.4’’ QVGA (320 x 240 pixels) TFT main display with 262K colours

Imaging and video
• Integrated 3.2 Megapixel EDOF FULL FOCUS camera with a 4 x digital smooth zoom

• Video recording in QCIF (15 fps) and playing up to VGA

• Video player with H.263, MPEG4, H.264, Real-time streaming, 3GPP streaming

Music
• Music Player for MP3, MP4, AAC, AAC+, eAAC+, WMA, WAV, NB AMR, WB AMR, MIDI

• Ring tones: Video, MP3, AAC, AAC+, eAAC+, WMA and 64 polyphonic ringing tones

• FM RDS stereo radio

Navigation
• Nokia Maps application

Productivity
Context management

• WM DRM ≥ 10, OMA DRM 2.0

• Organizer (Calendar + To-Do + Active Notes)

• PC Suite/Ovi Suite

• Active Standby

• Local/remote SyncML data sync

• Web Browser (OSS), XHTML browsing over TCP/IP

Messaging

• Email (native, OZ, Windows Live)

• OMA MMS 1.3 (300 kB MMS size), SMIL 2.0

• Audio Messaging (AMS)

• SMS

• Instant Messaging (IM) (native, Google talk, OZ, Windows Live)

• Social networks

Voice

RM-598; RM-604
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• Speech codec support for HR, FR, EFR, AMR and AMR WB

Add-on software framework
• Nokia Series 40, 3rd edition

• Java ™ MIDP 2.1

Additional features
• Macromedia Flash Lite 3.0

• Reminder light for missed events (IM, SMS, calls, etc.)

Sales package
• Transceiver RM-598/RM-604

• Battery BL-4CT (860 mAh)

• Charger AC-3

• Nokia wired stereo headset WH-102

• MicroSD card 2 GB

• User Guide

 Product and module list

Module name Type code Notes

System/RF module 2XGA

UI flex 2XHA

 Mobile enhancements

Table 1 Audio

Enhancement Type

Audio Adapter (2.5 to 3.5mm) AD-52

TTY adapter HDA-11

Wired headsets WH-102

WH-201

WH-205

WH-500

WH-600

WH-601

WH-700

WH-701
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Enhancement Type

Wireless headsets BH-103

BH-104

BH-105

BH-106

BH-212

BH-213

BH-214

BH-215

BH-216

BH-504

BH-606

BH-701

BH-703

BH-804

BH-904

Wireless loopset LPS-5

Table 2 Car

Enhancement Type

Auto Navigation Nokia 500 Auto Navigation

Car kit CK-7Wi

CK-100

CK-300

Holder easy mount HH-12

HH-17

Universal holder CR-39

CR-82

Wireless plug-in car handsfree HF-200

HF-310

HF-510

Table 3 Data

Enhancement Type

MicroSD card, 1 GB MU-22
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Enhancement Type

MicroSD card, 2 GB MU-37

MicroSD card, 4 GB MU-41

MicroSD card, 8 GB MU-43

MicroSD card, 16 GB MU-44

MicroUSB connectivity adapter cable CA-101

CA-101D

CA-126

Table 4 Music

Enhancement Type

Mini speakers MD-8

Wireless music speakers MD-7W

Table 5 Navigation

Enhancement Type

Wireless GPS Module LD-3W

LD-4W

Table 6 Power

Enhancement Type

Battery 860 mAh Li-Ion BL-4S

Back-up power DC-11

First aid charger DC-8

Mobile charger DC-4

DC-6

Retractable mobile charger DC-9

DC-10

Travel charger AC-4

AC-5

AC-6

AC-8

AC-10

USB Charger Adapter Cable CA-100

CA-100C

RM-598; RM-604
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Enhancement Type

Charger adapter (3.5mm to 2mm) CA-44

 Technical specifications

General specifications

Unit Dimension (mm) Weight (g) Volume (cc)

Transceiver with BL-4CT
860 mAh Li-Ion battery
pack

98 x 48 x 14.75 100 (with battery) 64

Battery endurance

Battery Talk time Standby time

BL-4CT 860 mAh Li-ion battery
pack

Up to 5.33 hours (GSM)

Up to 3.66 hours (WCDMA)

Up to 370 hours (GSM)

Up to 395 hours (WCDMA)

Note: Variation in operating times may occur depending on SIM card, network and usage settings,
usage style and environments.

Main RF characteristics for GSM 850/900/1800/1900, WCDMA 900/1900/2100 and WCDMA
850/1900/2100 phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA VIII
(900), WCDMA II (1900) and WCDMA I (2100)

Rx frequency band GSM850: 869 - 894 MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA VIII (900): 925- 960 MHz

WCDMA V (850): 869 - 894 MHz

WCDMA II (1900): 1930-1990MHz

WCDMA I (2100): 2110 - 2170 MHz
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Parameter Unit

Tx frequency band GSM850: 824 - 849 MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA VIII (900): 880 - 915 MHz

WCDMA V (850): 824 - 849 MHz

WCDMA II (1900): 1850-1910MHz

WCDMA I (2100): 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA VIII (900): -50 ... +24 dBm/0.01μW ...
251.2mW

WCDMA V (850): -50 ... +24 dBm/0.01μW ... 251.2mW

WCDMA II (1900): -50 ... +24dBm/0.01µW ...
251.2mW

WCDMA I (2100): -50 ... +24 dBm/0.01μW ...
251.2mW

EDGE output power EDGE850: +5 … +29dBm/3.2mW … 794mW

EDGE900: +5 … +29dBm/3.2mW … 794mW

EDGE1800: +0 … +26dBm/1.0mW … 400mW

EDGE1900:+0 … +26dBm/1.0mW … 400mW

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

WCDMA VIII (900): 152

WCDMA V (850): 108

WCDMA II (1900): 289

WCDMA I (2100): 277

Channel spacing 200 kHz (WCDMA V and II 100/200 kHz)
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Parameter Unit

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA VIII (900): 75

WCDMA V (850): 75

WCDMA II (1900): 75

WCDMA I (2100): 75

Environmental conditions

Temperature conditions

Environmental condition Ambient temperature Notes

Normal operation -10oC...+55oC Specifications fulfilled

Reduced performance -30oC...-10oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-30oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC

Humidity
Relative humidity range is 5...95%.

The HW module is not protected against water. Condensed or splashed water might cause malfunction. Any
submerge of the phone will cause permanent damage. Long-term high humidity, with condensation, will
cause permanent damage because of corrosion.

Vibration
The module should withstand the following vibrations:

• 5 - 10 Hz; +10dB / octave

• 10 - 50 Hz; 5.58 m2 / s3 (0.0558 g2/ Hz)

• 50 - 300 Hz; - 10 dB / octave

ESD strength
Conducted discharge is 8 kV (>10 discharges) and air contact 15 kV ( >10 discharges ).

The standard for electrostatic discharge is IEC 61000-4-2, and this device fulfils level 4 requirements.
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RoHS
This device uses RoHS compliant components and lead-free soldering process.
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 Service devices

Product specific devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-598; RM-604. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.

FS-120 Flash adapter

• FS-120 is equipped with a clip interlock system

• provides standardised interface towards Control Unit

• multiplexing between USB and FBUS media, controlled by VUSB

MJ-239 Module jig

MJ-239 is meant for component level troubleshooting.

The jig includes an RF interface for GSM and WCDMA. In addition, it has
the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• MMC interface

• Duplicated SIM connector

• Connector for control unit

• Access for AV- and USB connectors

Rework jigs and stencils
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-598; RM-604. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.

RJ-230 Soldering jig

RJ-230 is a soldering jig used for soldering and as a rework jig for the
engine module.
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General devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-598; RM-604. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.

AC-35 Power supply

Universal power supply for FPS-21; included in the FPS-21 sales
package.

Input 100V…230V 50Hz…60Hz, output voltage of 12 V and output
current up to 3 A.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PK-1.

FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.
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PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information

SRT-6 Opening tool

SRT-6 is used to open phone covers.

Note: The SRT-6 is included in the Nokia Standard Toolkit.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-21.
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SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-88 Camera removal tool

The camera removal tool SS-88 is used to remove/attach the camera
module from/to the socket.

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

Note: The SS-93 is included in Nokia Standard Toolkit.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-21 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-598; RM-604. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.

CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.
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CA-158RS RF tuning cable

Product-specific adapter cable for RF tuning.

• Table 7 Attenuation values

Band Attenuation Rx

GSM 850/900 0.30 dB

GSM 1800 0.38 dB

GSM 1900 0.41 dB

WCDMA I (2 GHz) 0.45 dB

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-21 to a PC. It is included
in the FPS-21 sales package.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-21 flash
prommer to the Point-Of-Sales (POS) flash adapter.
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CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.

DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.
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XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB

 Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BL-4CT Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software
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Type Description

Cables

CA-101 Micro USB cable

Flash concept with FPS-21

Figure 3 Basic flash concept with FPS-21

Type Description

Product specific devices

FS-120 Flash adapter

Other devices

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Service cable
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Type Description

USB cable

CU-4 flash concept with FPS-21

Figure 4 CU-4 flash concept with FPS-21

Type Description

Product specific devices

FS-120 Flash adapter

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card (for DCT-4 generation mobile device programming)

PC with Phoenix service software

Cables
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Type Description

PCS-1 Power cable

CA-89DS Service cable

Standard USB cable

USB cable

Module jig service concept

Figure 5 Module jig service concept

Type Description

Phone specific devices

MJ-239 Module jig

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

CA-89DS Service cable
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Type Description

PCS-1 DC power cable

XRS-6 RF cable

USB cable

GPIB control cable

Service concept for RF testing and RF/BB tuning

Figure 6 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

MJ-239 Module jig

Other devices

CU-4 Control unit

PK-1 SW security device

SX-4 Smart card

Measurement equipment

Smart card reader

PC with Phoenix service software
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Type Description

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

XRS-6 RF cable

GPIB control cable

USB cable

Bluetooth testing concept with SB-6

Figure 7 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

FS-120 Flash adapter

Other devices

CU-4 Control unit

SS-62 Flash adapter base

PK-1 SW security device

SX-4 Smart card

SB-6 Bluetooth test and interface box

Smart card reader
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Type Description

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

USB cable
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 Baseband self tests in Phoenix

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting.
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Troubleshooting flow
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 Power and charging troubleshooting

Dead or jammed device troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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Power key troubleshooting

Troubleshooting flow
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General voltage checking troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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General power checking
Check the following voltages:

Signal
Rename

Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO Pearl/Gazoo ON ON 1.8 Memory, I/Os,
display,
camera,
BTHFMTXRDS3.
0

VBACK Pearl/Gazoo ON ON 2.5 Back-up
battery

VSIM Pearl/Gazoo ON ON 1.8/3.0 SIM card

VAUX1 Pearl/Gazoo ON ON 2.8 Camera,
display and hall
sensor

VANA Pearl/Gazoo ON ON 2.5 Camera

VR1 Pearl/Gazoo OFF ON 2.5 Crystal
oscillators

VRFC Pearl/Gazoo OFF ON 1.8 RAP3Gv4
converters

VRCP1 Pearl/Gazoo 4.75 To RF parts

VREF Pearl/Gazoo ON ON 1.25 RF reference

VCORE Pearl/Gazoo ON ON 1.2 RAP3Gv4
digital

Can change due
to RAP3Gv4
version & SW

VOUT Pearl/Gazoo OFF OFF 2.5 Video switch

VMEM Pearl/Gazoo OFF OFF 2.9 microSD Disabled in
sleep
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Charging troubleshooting

Troubleshooting flow
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USB charging troubleshooting

Troubleshooting flow
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Battery current measuring fault troubleshooting

Troubleshooting flow
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Clocking troubleshooting

Troubleshooting flow

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Page 3 –16 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



 Interface troubleshooting

Flash programming fault troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2

Figure 8 Flashing pic 1. Take single trig measurement for the rise of the BSI signal
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Figure 9 Flashing pic 2. Take single trig measurement for the rise of the BSI signal
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SIM card troubleshooting

Troubleshooting flow
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MicroSD card troubleshooting

Troubleshooting flow
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USB data interface troubleshooting

Troubleshooting flow - Page 1 of 2

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –23
Copyright © 2009 Nokia. All rights reserved.



Troubleshooting flow - Page 2 of 2

 User interface troubleshooting

Keypad and side key troubleshooting

Context
If one or more keys are stuck, so that the key does not react when a keydome or the side key is pressed, the
failure is caused by mechanical reasons (dirt, rust, mechanical damage, etc.)

If the failure mode is not clear, start with the Keyboard test in Phoenix.
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Troubleshooting flow
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Reminder light troubleshooting

Troubleshooting flow
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Numerical keypad illumination troubleshooting

Troubleshooting flow
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Functional keypad illumination troubleshooting

Troubleshooting flow
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Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a sleep mode when the phone is in the screen saver mode.

Table 8 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 9 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.

Display module troubleshooting

Context
Use the display test tool in Phoenix to find the detailed fault mode.
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Troubleshooting flow
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Hall sensor troubleshooting

Troubleshooting flow
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 Bluetooth and FM radio troubleshooting

Bluetooth troubleshooting

Troubleshooting flow
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FM radio troubleshooting

Troubleshooting flow

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Page 3 –34 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



 Camera module troubleshooting

Taking and evaluating test pictures with main camera
When taking a test picture, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• If the phone is hot, let it rest for a while before taking the picture

• Make sure the optical system is clean

• Use highest possible resolution

• Make sure the light is sufficient (bright office lightning)

• Do not take the picture towards a light source

• Hold the phone as still as possible when taking the picture

• If camera has auto focus: Pictures should be taken both at infinity ~>2m and at macro distance ~10-15 cm
in order to verify auto focus functionality

When evaluating a test picture, remember the following:

• The center of the picture is sharper than the edges

• The image may be blurred, though it does not show in the viewfinder

• Analyse the picture from your PC monitor, full colour setting is recommended

• If possible, compare with a picture of the same motive taken with a similar Nokia device

• If camera has auto focus: Remember that the white focussing frame which appears when the camera
button is pressed halfway down, must turn green for auto focus lock. If the frame turns red, the camera
is not focussed!
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Camera troubleshooting

Troubleshooting flow

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Page 3 –36 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Camera hardware troubleshooting

Troubleshooting flow

 Audio troubleshooting

Audio troubleshooting test instructions
Single-endedl external earpiece and differential internal earpiece outputs can be measured either with a
single-ended or a differential probe.

When measuring with a single-ended probe each output is measured against the ground.
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Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• 'Active speaker' or 'speaker and power amplifier'

• Sound level meter

• Current probe

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to internal earpiece

• External microphone to internal handsfree speaker

• Internal microphone to external earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in a table in the following section.

Phoenix audio loop tests and test results
The results presented in this table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input
terminal

Output
terminal

Path
gain [dB]

Input
voltage
[mVpp]

Output
voltage
[mVpp]

Output
DC level

[V]

Output
current

[mA]

External Mic to
External Earpiece

XMICP and
GND

HSEAR R
and GND

16.7 100 680 1.2 NA

HSEAR L
and GND

External Mic to
Internal Earpiece

XMICP and
GND

EarP and
GND

10.9 100 353 1.2 NA

EarN and
GND

External Mic to
Internal
handsfree

XMICP and
GND

E2121 and
E2123 pads

28.1 100 2540 0 112mA
(calc.)
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Measurement data

Figure 10 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 11 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 12 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Page 3 –40 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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Internal handsfree (IHF) troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –45
Copyright © 2009 Nokia. All rights reserved.



Acoustics troubleshooting

Introduction to acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by the speaker. The acoustics of the phone include three basic systems: earpiece,
integrated handsfree (IHF) and a Clapton microphone (for noise cancelling).

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speaker radiates from the sound holes located on the bottom part of the
phone.

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.
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Earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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Microphone troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-20 or FPS-21.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2008.34/38 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• Activated FPS-20 flash prommer OR FPS-21 flash prommer

• Flash update package 08.30.012 or newer for FPS-20 or FPS-21 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-20 or FPS-21.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.

RM-598; RM-604
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –55
Copyright © 2009 Nokia. All rights reserved.



Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 10 Calibration value limits

Parameter Min. Max.

ADC Offset -30 +40

ADC Gain 12000 14000

BSI Gain 1100 1350

VBAT Offset 2635 2755

VBAT Gain 14900 15900

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• VAPAUS RFIC (N7500)

• TX FEM (N7520)

• WCDMA PA (N7540)

• Aura DC/DC converter (N7560)

Discrete components
In addition to the key components, there are a number of discrete components (resistors, inductors and
capacitors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Resistors: check value with an ohm meter.

Note: In-circuit measurements should be evaluated carefully.

Measuring equipment
All measurements should be done using:

• Module jig MJ-239

• Flash adapter FS-120

• Control unit CU-4/Interface adapter SS-46

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10MOhm/8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and a RF generator can be used. However, some tests in this
guide are not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (only if it is
possible to perform the measurement in a good RF-shielded room). Even low power WCDMA
transmitters may disturb nearby WCDMA networks and cause problems to 3G cellular phone
communication in a wide area.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to verify functionality of the cellular RF block without removing RF shield.

Instructions for finding the faulty component are provided in some cases, but the whole engine PWB (system
module) still needs to be swapped, even when a single component is faulty.
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RF key components

Figure 13 RM-598 RF key components - bottom
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Figure 14 RM-604 RF key components - bottom
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 Auto tuning

Introduction to auto tuning
This phone can be tuned automatically.

Auto tune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• PK-1/PDK-1 service dongle

• Power supply

• Product specific module jig

• Cables: RF cable XRF-1, USB cable, GPIB cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 15 Auto tuning concept with CMU200

Auto tuning procedure

Prerequisites
Install the phone-specific data package, e.g. Nokia_firmware_RM598/RM604_DP20_3.471__sw-ce3.37.exe.

The data package defines the phone-specific settings.

Steps
1. Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2. Go to loss settings by selecting Tuning (Alt_U)→SET LOSS  from the menu.

3. Set the loss between CMU200 and the phone. (Total loss = cable + jig)

4. Go to auto tuning by selecting Tuning (Alt_U)→Auto-tune (Alt_A)  from the menu.

5. Start auto tuning by clicking the Tune button.

RM-598; RM-604
RF Troubleshooting

Page 4 –8 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



 Self test troubleshooting

Phoenix self test troubleshooting

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting in
Chapter 3, BB Troubleshooting and Manual Tuning Guide.

Note: Self tests are recommended to be made when phone is in jig and a 50Ω load connected to
the RF connector. Otherwise power tests may fail depending on antenna load.
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Troubleshooting flow
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 Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.

The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see section GSM RX chain activation for manual measurements/
GSM RSSI measurement (page 4–11) . For a similar test in WCDMA mode, see section WCDMA RSSI
measurement (page 4–14).

The RX path for GSM and WCDMA are using the same filters in some bands. Please refer to RF component
reference (page 4–27) for details.

GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in signal generator and Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.46771MHz
(67.71kHz offset)
at -60dBm

942.46771MHz
(67.71kHz offset)
at -60dBm

1842.86771MHz
(67.71kHz offset)
at -60dBm

1960.06771MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix by selecting Testing→GSM→RSSI reading .

Figure 16 Phoenix RSSI Reading window

Results
The reading should reflect the level of the signal generator (minus losses) ±5dB.

When varying the level in the range -30 to -102dBm the reading should then follow within ±5dB.
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GSM receiver troubleshooting flowchart

Troubleshooting flow
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WCDMA RX chain activation for manual measurement

Steps
1. In Phoenix, select Testing→WCDMA→Rx Control . The Phoenix Rx Control window opens.

Figure 17 Phoenix Rx Control window with sample settings (WCDMA band I)

2. Make settings for the band to be tested according to the following table:

Band to be tested Phoenix Channel Signal generator to antenna
connector

WCDMA I 10700 2141 MHz

WCDMA II 9800 1960 MHz

WCDMA V 4408 881.6 MHz

WCDMA VIII 3013 943.6 MHz

3. Make the following general settings (the same values for all bands):

Setting Value

AGC Mode Algorithm

AFC Algorithm OFF

AFC DAC 1024

4. Click Start to activate the settings.
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If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.

Note: Clicking Stop also disables TX control if it was active.

WCDMA RSSI measurement

Prerequisites
WCDMA RX must be activated before RSSI can be measured. For instructions, please refer to WCDMA RX chain
activation for manual measurement (page 4–13).

Connect signal generator to RF connector and use appropriate frequency for each channel.

Steps
1. In Phoenix select Testing→WCDMA→RX Power measurement . The Rx Power Measurement window

opens.

Figure 18 Phoenix Rx Power Measurement window

2. In the RX Power measurement window, select:

• Mode: RSSI

• Continuous mode

3. Click Start to perform the measurement.

Note: WCDMA RSSI measurement is accurate only with WCDMA modulated signal.
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WCDMA receiver troubleshooting flowchart

Troubleshooting flow
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 Transmitter troubleshooting

Introduction to transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Control”; in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production.

• The TX path for GSM and WCDMA are using the same filters in some bands. Please refer to RF component
reference (page 4–27) for details.

Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2W dummy load);
otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→GSM→Rf Controls . The RF Controls window opens.

Figure 19 Phoenix RF Controls window
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3. Make the following settings:

Setting Value

Active Unit Tx

Rx/Tx Channel 37

Band GSM 900

AFC 0

Operation Mode Burst

Edge Off

Tx Data Type Random

Tx PA Mode High

Tx Power Level 5

4. Check the basic TX parameters, using a communication analyser (e.g. CMU200).

• Power

• Phase error

• Modulation

• Switching spectrum
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Figure 20 Typical readings

5. Change the power level in RF controls window and make sure the power reading follows accordingly.
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Next actions
You can troubleshoot the GSM transmitter for each GSM band separately, one band at a time. If you want to
troubleshoot GSM850, GSM1800 or GSM1900, change the band in the RF controls window and set the
communication analyser accordingly.
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GSM transmitter troubleshooting flowchart

Troubleshooting flow
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WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→WCDMA→Tx control . The Tx Control window opens.

Figure 21 Phoenix WCDMA Tx control window

3. Make settings for the band to be tested, according to the following table:

Band Channel

WCDMA I 9750

WCDMA II 9400

WCDMA V 4183

WCDMA VIII 2788

4. Make the following general settings (the same values for all bands). Note that Max power limit is not
checked by default.
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Setting Value

DPDCH enabled Checked

Max power limit Checked

Start Rx Checked

Start level 23

Step size 0

Step count 0

Sequency 0

Step duration 2550

Code class LONG

Code 16

DPDCH code 0

Weight 15

Code class 2

DPCCH code 0

Weight 8

Code class 2

Note: Use the Start level option to set the TX power level.

5. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel selected), you have to click RF Stop and Send again.

6. Check the basic TX parameters using a communication analyser (e.g. CMU200).
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Figure 22 Typical readings
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WCDMA transmitter troubleshooting flowchart

Troubleshooting flow
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 Troubleshooting with RF shield removed

Introduction
The RF-shield should not be removed in order to replace single components on the RF block. This chapter
only assists in locating the faulty component for statistical purposes.

Voltage checking

Steps
1. Set up the main board in the module jig. The phone should be in local mode.

2. Check the following:

TP# Signal name Test point Voltage (all bands)

1 VCTCXO (G7500) supply C7501 2.5V

2 RFIC Vapaus (N7500) supply from DC/DC
converter

C7570 2.8V

3 TXFEM (N7520) supply from DC/DC
converter

C7521 1.3V-3.8V (only when transmitting and
depends on output power).

4 WCDMA PA (N7540) supply from DC/DC
converter

C7528 0.7V-3.1V (only when transmitting and
depends on output power). The value
will be 3.1V when settings as described
in the note below are used.

5 Vbat at WCDMA PA (N7540) C7512 3.7V (Vbattery)

6 Supply input to DC/DC conv C7527 3.7V (Vbattery)

Note: The result at TP4 should be 3.1V when using the same settings as shown in Figure Phoenix
WCDMA Tx control window in section WCDMA transmitter troubleshooting (page 4–21).
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Figure 23 Test points for voltage checking
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VCTCXO troubleshooting

Troubleshooting flow

RF component reference

Component reference table
These table show the components used for the different bands. It can be used as a reference when
troubleshooting which components may or may not be faulty.

Table 11 RM-598 RF component reference

RM-598 GSM 850 GSM 900 GSM 1800 GSM 1900 WCDMA I WCDMA II WCDMA V

Reference RX TX RX TX RX TX RX TX RX TX RX TX RX TX

G7500 X X X X X X X X X X X X X X

L7500 X X X X X X X X X X X X X X

N7500 X X X X X X X X X X X X X X

N7520 X X X X X X X X X X X X X X

N7540 X X X

N7560 X X X X X X X X X X X X X X

T7520 X X

Z7521 X X

Z7523 X X

Z7540 X X X

Z7541 X X

Z7542 X X X

Z7543 X X
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RM-598 GSM 850 GSM 900 GSM 1800 GSM 1900 WCDMA I WCDMA II WCDMA V

Reference RX TX RX TX RX TX RX TX RX TX RX TX RX TX

Z7544 X

Table 12 RM-604 RF component reference

RM-604 GSM 850 GSM 900 GSM 1800 GSM 1900 WCDMA I WCDMA II WCDMA VIII

Reference RX TX RX TX RX TX RX TX RX TX RX TX RX TX

G7500 X X X X X X X X X X X X X X

L7500 X X X X X X X X X X X X X X

N7500 X X X X X X X X X X X X X X

N7520 X X X X X X X X X X X X X X

N7540 X X X

N7560 X X X X X X X X X X X X X X

T7520 X X

Z7521 X X

Z7523 X X

Z7540 X X X

Z7541 X X

Z7542 X X X

Z7543 X X

Z7544 X

X means that the component is used for the band in the current column.

For further reference, see Component reference schematics in the following figure.
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RF block schematics

Figure 24 Component reference schematics

 Antenna

Antenna overview
The phone has two antennas, a main antenna and a BT antenna. Their placement in the phone can be seen
in the following figure:
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The main antenna consists of an antenna flex attached to an antenna carrier with an adhesive. This is called
Cellular Antenna Module. The Cellular Antenna Module also acts as top of an IHF chamber, which is built
together with the D-Cover. For acoustical sealing of the IHF chamber a sealing is glued on the bottom side
of the Cellular Antenna Module. The Cellular Antenna Module is snapped in the D-Cover and the IHF speaker
is in between the Cellular Antenna Module and the D-Cover.

The Bluetooth antenna also consists of an antenna flex attached to an antenna carrier with an adhesive. It
is put in the D-Cover at the side of the phone opposite to the volume key. In the fully assembled phone it is
hidden by the D-Cover Trim.

Main antenna functionality
The main antenna consists of two radiators which cover different frequency ranges. One radiator covers the
range 824 MHz to 960 MHz, the low band, and the other radiator the ranges 1710 MHz to 1990 MHz as well
as 2110 MHz to 2170 MHz, the high bands.

Both radiators are matched monopoles, the matching network consists of components, which are soldered
on the antenna flex and are located on the bottom side of the assembled antenna module.

There are three pads close to the matching network. They act as contact areas for the C-Clips on the PWB.
The outer ones are ground, and the middle area is the antenna feed, as shown in the following figure.
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Figure 25 Antenna contacts

The main antenna functionality must also be checked by a GoNoGo test as described in Technical Bulletin TB
214.

Bluetooth antenna functionality
The Bluetooth antenna is an IFA type. The grounded branch is a wired line on the PWB, the other branch is
a wire on the flex. The Bluetooth antenna includes a spring clip, which establishes the contact to Bluetooth
feed via a gold plated contact area on the PWB.

Figure 26 BT antenna

Antenna troubleshooting

Main antenna
Check that the GND and feed pads take proper contact to the C-Clips on the main PWB. Also check visually that
all the matching components are soldered on the flex. In case of damage, the whole antenna module needs
to be replaced.

If only low band or high band is working properly, it may indicate a faulty matching network. Defects in the
solderings or breaks in the wiring of matching should be seen. In this case, also antenna module needs to
be replaced.
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Bluetooth antenna
Check that the spring clip takes proper contact to the gold plated contact area on the PWB. Also check that
the spring clip fits well in the Bluetooth antenna and has a proper contact to the wire in the PWB. In case of
damage, the whole antenna needs to be replaced.
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 Introduction

Phone description
RAP3GS is the main digital baseband ASIC in the device. It contains functionality for both WCDMA and GSM
EDGE. The cellular baseband is constructed around Radio Application Processor (RAP3GS2v4) and mixed signal
ASIC GAZOO/PEARL. RAP3GS2v4 is used as a single chip solution, which means that all UI components are
connected to RAP3GS2v4.

N2200 is the main audio and energy management controller for the phone. The mixed-signal functionality
is in one mixed-signal ASIC. In the cellular baseband there are two alternative pin compatible mixed signal
ASICs; GAZOO and PEARL. N2200 includes blocks for charger control, SMPS power supplies for VCORE, VIO and
LEDs, linear regulators for RF and BB supplies, level shifter functions, A/D converters, audio and RTC.

Bluetooth and FM radio are physically integrated in one single ASIC.

Key components

Function Description Item ref

Main board 2XGA

UI flex 2XHA

Energy management ASIC GAZOO/PEARL N2200

RF ASIC Vapaus N7500

Processor RAP3GS2v4 D2800

PA GSM Front end module (FEM), quad band N7520

PA WCDMA Triple band PA N7540

Oscillators VCTCXO G7500

Memory 1 Gbit M3/ DDR SDRAM 512 Mbit combo (stacked with RAP) D3000

FM radio BTHFMRDS3.0 module N6000

Bluetooth BTHFMRDS3.0 module N6000

Slide switch Hall IC switch/position sensor N2460

Battery BL-4CT

Battery connector Tabby blade interface X2080

UI flex connector Coax 40-pin connector X1000

MicroUSB connector For data and charging X2002

MicroSD connector X3200

SIM connector X2700

Microphone B2104

IHF speaker

Earpiece On UI flex B1000
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Key component placement
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System module block diagram
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Board and module connections

 Energy management

Battery and charging

BL-4CT battery
The phone is powered by a 3-pole BL-4CT 860 mAh battery. The three poles are named VBAT, BSI and GND
where the BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull
down resistor.

Figure 27 Battery pin order

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)
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• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Charging
This phone is charged through a separate charger connector.

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Complementary USB charging is supported as well, in case the phone is connected to a PC or to a dedicated
USB charger.

Normal and extreme voltages
Energy management is mainly carried out in the ASIC PEARL/GAZOO. These circuits contain a number of
regulators. In addition there are some external regulators.

In the table below normal and extreme voltages are shown when a BL-4CT battery is used.

Table 13 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 4.1

Lower extreme voltage 3.5

Higher extreme voltage (fast
charging) 4.2

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.106 In call

Sw shutdown 3.2 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.7 ± 0.1 On to off

Power key and system power-up
When the battery is placed in the phone the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). The power key is connected to EM ASIC N2200 (Gazoo/Pearl) via PWRONX signal.
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Modes of operation

Mode Description

NO_SUPPLY (Dead) mode means that the main battery is not present or its voltage is too low (below
N2200 Gazoo/Pearl master reset threshold) and that the back-up battery voltage is too
low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over N2200 Gazoo/
Pearl master reset threshold. All regulators are disabled, PurX is on low state, the RTC
is on and the oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF
(warm), but the RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32 kHz clock to count
the REST mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Clocking scheme
In BB5.0, two main clocks are provided to the system: 38.4MHz RF clock produced by VCTCXO in RF section
and 32.768kHz sleep clock produced by EM ASIC N2200 with an external crystal.

32 k Sleep Clock is always powered on after startup. Sleep clock is used by RAP for low-power operation.

SMPS Clk is 3.2 MHz clock line from RAP to EM ASIC N2200. In deep sleep mode, when VCTCXO is off, this signal
is set to '0'-state.

RF CLK Ext is 38.4 RF CLK Ext from Vapaus ASIC. It is buffered in N7500 and distributed to BTHFMTXRDS.

 Connectivity

MicroUSB interface
The micro USB (Universal Serial Bus) provides a wired connectivity between a PC and peripheral devices. It is
a differential serial bus. USB 2.0 is supported with full speed (12 Mbps).

Hot swap is supported, which means that USB devices may be plugged in/out at any time.

This phone is equipped with a μUSB connector (AB type) which accepts CA-101 or an appropriate 3rd party
data cable to establish a USB connection.

Figure 28 MicroUSB connector
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SIM interface
The phone has a SIM (Subscriber Identification Module) interface including a SIM connector. The connector
is only accessible when the battery is removed.

The interface is located into two ASICs; RAP3GS2v4 contains most of the interface functionality and MS ASIC
takes care of card power up/down, card detect, ATR counting and level shifting functions.

Figure 29 SIM interface

The SIM interface supports 1.2V, 1.8V and 3V technology smart cards.

MicroSD card interface
The microSD card is connected to the engine through the level shifter in Pearl/Gazoo to adapt the 1.8V I/O IF
of the RAP3GS2v4.x to the 3V IF of the SD IF.

The microSD card can only be removed or inserted when the battery is removed.

Figure 30 MicroSD card interface

USB interface
The phone has an interface for USB (Universal Serial Bus) and it supports device mode. Device mode means
that the mobile terminal can be a USB device for a USB host such as PC.
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Figure 31 USB interface

The phone supports full speed (12 Mb/s) in device mode.

Charger interface
The charger interface is a 2 mm Dynamo charger plug. Older chargers with a 3.5 mm plug are supported via
the charger adapter cable CA-44.

Charging is controlled by GAZOO (N2200). Additional external components are needed for EMC purposes,
reverse polarity and transient protection of the input to the baseband module.

Figure 32 Charger interface
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Bluetooth
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
module.

The Bluetooth is physically integrated with the FM radio into one single module. From a functional point of
view they, however, have nothing in common.

Figure 33 Bluetooth interface

The Bluetooth has a separate built in antenna and is powered by VBAT and the regulated voltage VIO. For
audio applications the Bluetooth has a PCM data bus. In addition a UART (universal asynchronous receiver/
transmitter) is used for data communication and controls.

FM radio
The FM radio is physically integrated with the Bluetooth into one single module. From a functional point of
view they, however, have nothing in common.
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Figure 34 FM interface

The FM radio is an integrated circuit, controlled by MCU software through a serial bus interface. The wires of
the headset are used as poles of the antenna, and no other antenna is needed for FM radio reception.

 User interface

Display module

Display module
The display module consists of a large 2.4’’ QVGA (320 x 240 pixels) TFT display with 262K colours.

The interconnection between the display module and RAP engine is implemented with a 25-pin board-to-
board connector. The display module is equipped with a driver with bi-directional 8-bit parallel interfaces.
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Keyboard interface

Figure 35 Keypad matrix

Backlight and illumination
The illumination has four main areas: numeric keypad (4 x white LEDs), functional keypad (UI) (2 x white
LEDs), display backlight (3 x white LEDs) and reminder light (1 x white LED). The display backlight is powered
by the integrated DC/DC converter of the Pearl/Gazoo IC. In addition to these LEDs, the two functional keypad
LEDs are powered via a current mirror from the Pearl/Gazoo.

The reminder LED is directly switched to VBAT via GENIO1. In the VLED+ line of the Pearl a “VLED disconnect
switch” is integrated. This avoids that the VLED line is at VBAT level even in switched off state (which can
cause electro migration problems).
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Figure 36 Backlight and illumination concept

Slide switch interface
The form factor of this phone is slide, which means that it has to wake up when it slides open. The slide
operation is sensed by a MR sensor (hall sensor) mounted on the main PWB and a magnet fitted to the sliding
mechanism.

The MR sensor output is active low (0V) and 1.8V when not active. This enables the phone to detect closed
and open position.

The output of the sensor is connected to GenIO38 of RAP3GS2v4.

Figure 37 Hall sensor schematic
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 Camera concept

Camera interface
The camera module is a EDOF 3.2 Mpix. The camera is connected directly to the baseband, no hardware
accelerator is used. Processing of the image is done by phone processor using NIPS (Nokia Imaging Perfection
System) algorithms.

The CCI-bus (Camera Command Interface) is an I2C-compatible interface that is used bidirectional to transfer
commands from BB to the camera and to get information of the camera register settings from the camera
to BB.

The CCP-bus (Compact Camera Port) is a unidirectional interface that is used to transfer the image data from
the camera to BB. It is a high speed differential interface. The camera is equipped with CCP class2 interface,
i.e. up to 650 Mbit/s. The device baseband supports CCP class0 (specified up to 208 MHz) but limits the
frequency to 160 MHz. So clock/data-signaling is used in the device.

Figure 38 Camera concept

 Audio concept

Audio concept
The functional core of the audio hardware is built around two ASICs; Energy management ASIC N2200 and
digital ASIC D2800.

N2200 provides an interface for the transducers and the AV connector.

There are three audio transducers:

• one earpiece

• one IHF speaker

• one Clapton microphone

N2200 also provides an output for the vibra motor.

All external audio accessories are connected to the specific AV connector.

The following block diagram illustrates the audio interface of the phone:
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Figure 39 Audio block diagram

Internal audio
The internal audio components are used in these modes:

Hand portable (HP) mode Internal hands free (IHF) mode

Microphone X X

Earpiece X

Speaker X

Internal microphone
The Clapton microphone is located in the antenna module. The MIC1P connects directly to the EM ASIC N2200
(Gazoo/Pearl).
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Figure 40 Internal microphone

Internal earpiece
The internal earpiece (B1000) is located at the top side of the UI flex. The earpiece is directly driven by the
internal ear amplifiers of the Pearl/Gazoo (N2200) and no additional amplifier is needed

Figure 41 Internal earpiece

IHF speaker
The IHF speaker (E2121/E2123) is located at the bottom side of the main board. No additional amplifier is
used.

RM-598; RM-604
System Module

Issue 1 COMPANY CONFIDENTIAL Page 5 –19
Copyright © 2009 Nokia. All rights reserved.



Figure 42 IHF speaker

External microphone
An external microphone can be connected to the device via the 3.5 mm AV connector (X2100) located at the
bottom side of the main board.

Figure 43 AV connector

External earpiece
An external earpiece can be connected to the device via the 3.5 mm AV connector (X2100) located at the top
side of the phone.

The external earpiece is directly driven by the internal amplifier of Gazoo/Pearl. There are no external
amplifiers.
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Figure 44 AV connector

Figure 45 AV interface

Vibra
The vibra (M2100) is a mounted SMD located at the bottom side of the main board. It is supplied directly from
the Pearl/Gazoo vibra outputs.
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Figure 46 Vibra

AV connector
The 3.5mm AV connector consists of mono or stereo audio output, mono audio input and optional features
like control data over microphone line.

A connected male connector is detected on pin 6 (PLUG_DET).

Accessories are detected as basic headset (no ECI) or as intelligent ECI communication devices.

Note: Only use an approved cable for connecting to the AV connector ( e.g. headset HS-47).

Figure 47 AV connector pin layout

Table 14 AV connector pins

Pin Signal name Direction Description

1, 2 HS_ GND - Ground contacts

3 HS_MIC Input Multiplexed microphone audio and control
data/muxed: MIC2P and ACI, control: GenIO34

4 HS_EAR_R Output Audio output (XEAR_R)

5 HS_EAR_L Output Audio output (XEAR_L)

6 PLUG_DET Input Terminal internal connection, plug detection/
GenIO 33
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 Combo memory
The die stacked combo memory module POP2 (1Gbit M3/ DDR SDRAM 512 Mbit) is assembled on the top of
RAP3GS2v4, and located at the bottom side of the main board. RAP3GS2v4 has pads on the top of it, where
POP2 is soldered.

 RF description

Block diagram

Figure 48 RF block diagram RM-598 using RF ASIC N7500
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Figure 49 RF block diagram RM-604 using RF ASIC N7500

The RF block diagram uses RF ASIC N7500 (Vapaus) that performs the RF back-end functions of receive and
transmit function of the cellular transceiver.

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (e.g. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.
The principle of GSM and WCDMA is the same.

Transmitter (TX)
The digital baseband signal (e.g. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the bandwith
of the system in use (e.g. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals are sent via different components, the principle of the transmission
is the same.
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A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo
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DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FM Frequency Modulation

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity
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IR Infrared

IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MP3 Compressed audio file format developed by Moving Picture Experts Group

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PCM Pulse Code Modulation

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board
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PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RDS Radio Data Service

RF Radio Frequency

RF PopPort™ Reduced function PopPort™ interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC
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USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)
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